Exercise 3: Spatial Analysis
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Goal

The goal of this exercise is to serve as an introduction to Spatial Analysis with ArcGIS.

Objectives

e Calculate slope from a grid digital elevation model

o Apply model builder geoprocessing capability to program a sequence of ArcGIS functions

e Use ArcGIS.com services to access and extract elevation data

¢ Interpolate data values at points to create a spatial field to use in hydrologic calculations. Use this to

calculate watershed area average precipitation
e Use raster data and raster calculator functionality to calculate watershed attributes such as mean
elevation, mean annual precipitation and runoff ratio.

Computer and Data Requirements
To carry out this exercise, you need to have a computer, which runs ArcGIS Pro 2.2 or higher. The

necessary data are provided in the accompanying zip file,
http://hydrology.usu.edu/dtarb/giswr/2018/Ex3Data.zip



http://hydrology.usu.edu/dtarb/giswr/2018/Ex3Data.zip

Part 1. Slope calculations

1.1 Hand Calculations

Given the following grid of elevations, refer to the slides
http://hydrology.usu.edu/dtarb/giswr/2018/Spatial Analysis.pptx from lecture 7 and calculate by hand the
slope and aspect (slope direction) at the grid cell labeled A using

(1) The standard ESRI surface slope function (slides 41-44)

(i) The 8 direction pour point model (slides 45-46)

(iii)  The Dinfinity algorithm (slides 49-50).

Grid cell size 10m

25.4 26.1 27 28.6 27.7
25 26.0 26.4 A 27.9 27.4
25.1 25.8 26.8 B 28.6 27.6
27.5 28 27.7 30.6 28.3

Hint: For Dinfinity you only need to consider the single triangle bounded by values 26.0, 26.4 and 25.8 in
the calculation

- 10—% .
e
4 3 2
Zs — Zg
, a = atan
N\ s /. Zog — Z3
"1°26.0 }6‘.4 1
al'ﬂlll// Z5_ZG 2 ZO_ZS 2
1 s= |(G5) + (5
Zs/725.8 7 8 A A

Comment on the differences and indicate which you think is a better approximation of the direction of
water flow over the surface.

To turn in: Hand calculations of slope at point A using each of the three methods and comments on the
differences.


http://hydrology.usu.edu/dtarb/giswr/2018/SpatialAnalysis.pptx
http://hydrology.usu.edu/dtarb/giswr/2018/SpatialAnalysis.pptx

1.2 Verifying calculations using ArcGIS
Verify the calculations in (1.1) using ArcGIS Hydrology and Surface Toolbox functions.

Save the following to a text file ‘elev.asc' (This file is also included in
http://hydrology.usu.edu/dtarb/giswr/2018/Ex3Data.zip)

ncols 5
nrows 4
xllcorner 0
yllcorner 0
cellsize 10

NODATA value -9999

25.4 26.1 27 28.6 27.7
25 26.0 26.4 27.9 27.4
25.1 25.8 26.8 28.6 27.6
27.5 28 27.7 30.6 28.3

This shows how raw grid data can be represented in an ASCII text format that ArcGIS can import.
Knowing how to get raw information into a form where it can be imported and analyzed using GIS is a
useful skill.

Open ArcGIS Pro, establish a new project called Ex3Slope
Create a Mew Project

Create a new project

Select a project template

Mame Ex3Slope

Location | ChUsers\dt\Desktop\Ex3

Blank Create a new folder for this project

Add a New Map to the Project

PROJECT
=5 New

1&' Impo
New | —
Map~| £ Conni

and use Add Data ' to add this file to the map. Note that ArcGIS interprets files with the .asc type
extension as raster files in this ASCII format and can work with them directly.

Zoom to the raster layer that was added.


http://hydrology.usu.edu/dtarb/giswr/2018/Ex3Data.zip
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The first thing you’ll notice is that this grid is in the middle of the ocean. This is because its corner
coordinates (0, 0) are not linked to a specific coordinate system and position on the Earth. This is fine in
this example and illustrates ArcGIS ability to perform generic raster calculations. Turn off (or Remove) the
Topography layer because the background map is not needed. Right click on the elev.asc layer and using
Symbology, color the layer so that the range in elevation values is more readily visualized. You can click
on any of these cells to verify that the numbers correspond to the values in the table above.
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Select Analysis/Tools to add Geoprocessing to the right panel
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In the Geoprocessing panel, select the Toolboxes header and open the tool Spatial Analyst Tools >
Surface = Slope.
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Hover over the @ to see help information, and click on the @' to open up a webpage with more details.
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Select elev.asc as the input raster and specify names for the output raster (e.g. slope). Note that the
extension you put on an output raster name designates its type. (e.g. no extension for an ESRI grid, .tif for
a geotiff file, .img for an Image file). Note that ESRI GRID file names outside of Geodatabases cannot
exceed 13 characters. Set the Output measurement to PERCENT_RISE and leave the Z factor at 1 and
method as Planar. Click Run.

The resulting Slope grid should be added to the display. Click on the raster to verify your hand calculation
for grid cell A and note the value of slope for grid cell B.
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Note also that slope was not computed for the edge cells due to insufficient information.



Open the tool Spatial Analyst Tools - Surface - Aspect. Select elev.asc as the Input raster and specify
a name for the output raster (e.g. aspect). Click Run.
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The resulting Aspect grid should be computed and added to the display. Click on the raster to verify your
hand calculation for grid cell A and note the value of aspect for grid cell B.

[ T B T Furites Layet ANCTlS Pre - BxSlinge - Map 7 - o "
Map it | snalei | View  Ede tmagery  Shae  Appearance Data & ks (Unah State Univeridy] =

- I - i~ R x sl [T c 0 - = = - | =
mE o XEE B8 B B M B U 88 B & %
History Pythen ModelBuilder Environments Tools ResdyTo  Festure  Raster sgatil clig intiriedt Uniam ttter tiear Gentrate |~ Nebwork Geostatisticsl  Raster  Function
Use Took = Analysss = Analysis = sain tiear Ui (3| Anabygse Wisrd  Funcions  Editor
Grapracenng i Portsl Toadt Raster Data Ingernperabadity
Contents BRI A = Geoprocessing e
Y [Search s ® Aspect =
B0 N/ 8H&I Parameters | Emirsrmars: )
Inget raszes
Drawing Orcler elevas +
+ [Pl Map & Output rastes
fZ e preoe +
reen Methed
E Mt Planar
W reonh 0225
[ Northeast (22.5-67.5)
O et 51125
B southess (11251575
1O seuth 15752005
B Southwest (202.5-2475)
W wen pans-z25)
W ot (29253578
W rooth (337.5-360)
[ stope
O
3 s6
@ :n
[ T
@
B s
W :»
B
| EL
| ke
1.000
o [ eleviase =
Value ["Ran ]
[k b o Aspect
| Completed successtully
- 13 <} B g OO00ATRI'E Q001 183N alarted Pt *  Catalog | feeprocessing | Symbology

Open the tool Spatial Analyst Tools - Hydrology = Flow Direction
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Select elev.asc as the input raster and specify names for output rasters (e.g. FlowDir and PercDrop).
Leave the Flow direction type as D8. Note that the help explanation that appears when click on the output
drop raster field in the dialog box explains that the Output drop raster is really the slope expressed as a
percentage. Click Run.



Flow Direction (Spatial Analyst Tools)

Creates a raster of flow direction from each cell to its downslope neighbor, or neighbors,
using D8, Multiple Flow Direction (MFD) or D-Infinity (DIMNF) methods,

Dir
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Input surface raster
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Click on the FlowDir and PercDrop grids that are created to verify that the numbers correspond to the
values you calculated by hand; resolve or reconcile any differences. Note that the PercDrop value that the

Flow Direction tool reports is different from hand calculations. This is a discrepancy that | have pointed

out to ESRI and they acknowledged it is a problem, but have not yet corrected.

Record in a table the ArcGIS calculated flow direction and hydrologic slope (Output drop) at grid cells A

and B.

Now set the Flow direction type to DINF in the Flow direction tool, and set different names for Output
flow direction raster and Output drop raster, and Run.

Geoprocessing

®© Flow Direction

Parameters | Ervironments

Input surface raster

-~ I X

@

elev.asc

Output flow direction raster

|f|owdirDinf

[]Forceall edge cells to flow cutward
Output drop raster

| percdropDinf

Flow direction type

| DINF




Click on the FlowDirDinf and PercDropDinf grids that are created and record the values at grid cells A and
B.

To turn in: Table giving slope, aspect, hydrologic slope and flow direction at grid cells A and B. For
hydrologic slope report results from both D8 and DINF methods. Include in your solution diagrams or
sketches that define or indicate what each of these numbers means for the specific values obtained for cells

A and B.

1.3 Automating procedures using ModelBuilder

ModelBuilder provides a convenient way to automate and combine together geoprocessing tools in
ArcToolbox. Here we will develop a ModelBuilder tool to automate the importing of the ASCII grid and
calculation of Slope, Aspect, Hydrologic Slope and Flow direction.

ArcGIS Pro projects come with toolboxes already created, where you can create new models, scripts, and
toolsets. In the Catalog panel Project tab expand Toolboxes and find the Ex3Slope toolbox.

Catalog X
Project | Portal | Favorites | MNotifications =
Search o
o Maps

4 [m Toolboxes

f‘&l Ex35lope.thx

ol Databases

Right-click on Ex3Slope.thx and select New = Model.

4 = Toolboxes

ft-h Ex3Slope.thx J
=l Datak Mew FL o Model
“3 Geop = New Maodel
= Styles Refresh Ea _
o ] LETrES Create a new Model in the
v Folde Cave As . toolbox.

The model window should open in the main part of the display. This is a window where you can drag,
drop and link tools in a visual way much like constructing a flow chart.

In the Geoprocessing panel, browse to Conversion Tools 2 To Raster = ASCII to Raster.
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s
4 o To Raster
o~

ASCI to Raster

“.. DEM to Raster

M Cocbiienmin Docben

Drag this tool onto the model window (middle of screen). Note that in this model | am choosing to first
import the ASCII text file to an ESRI GRID format, rather than work with it in text format. It is faster to
work with binary formats like .tif or ESRI GRID.

] ] O O O O
O ASCI to Raster @ 1 Cutput raster O
] O O O O O

Double click on the ASCII to Raster rectangle to set this tool's inputs and outputs.

ASCIl to Raster bt

Parameters | Environments (2
Input ASCI raster file
ChUsers\dth\Desktop'\Ex3'elev.asc

Output raster

ASClITo_asc

Output data type
Float =

Set the Input ASCII raster file to elev.asc and Output raster to elevm (I used elevm to indicate this is a
result from the model). Set the output data type to be Float. Click OK to dismiss this dialog. Note that
the model elements on the ModelBuilder palette are now colored indicating that their inputs are complete.

elev.asc = ASCI to Raster = elevm

11



Locate the tool Spatial Analyst Tools = Hydrology = Flow Direction and drag it on to your window.
Your window should appear as follows.

elevasc = ASCI to Raster = elevm

Qutput flow

T LR " direction raster

Output drop
raster

The output from the ASCII to raster function needs to be taken as input to the Flow Direction function. To
do this click-and-drag a line from elevm, the Output raster of ASCII to Raster, to the Flow Direction tool
rectangle. At the dialog that pops up select Input surface raster to indicate that elevm is to be used as the
input Surface raster for the Flow Direction tool. The “m” in these names is to signify that the results are
being created from a model rather than by using the tools one by one.

elev.asc = ASCIl to Raster = elevm

=S

Flow Dire Input surface raster ster

Snap Raster
Extent

Cell Size
Mask

Precondition

UUTpUT arop
raster

Notice that the "output drop™ oval is gray. This is because this is an optional output that has not been

specified. Double click on the Flow Direction tool and specify names for both the Output flow direction
raster and optional Output drop raster.
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ASCIl to Raster ——— .
Flow Direction X
Parameters | Environments ()]
F Input surface raster
| elevm '|

o Qutput flow direction raster
Flow Direction | flowdirm |

9 [Farceall edge cells to flow outward
Cutput drop raster
| percdropm |

Flow direction type
D8

Click OK. Alternatively you could double click on output ovals individually to specify the output rasters.
The model is now ready to run. Run the model by clicking the Run button in the ModelBuilder tab.

MODELBUILDER INSERT ANALYSIS VIEW SHARE

%o el B s EREESaR (C

« Validatyl| Run § Tools Variable Iterators Utilities Logical Label Group Un

Mew Save Save Properties Environments  Aute  FitTeo
As Layout Window @'[ Pan
Model View Mode Run Insert Grou

cox Bve BT

o
. | > ASCII to Raster
M/ 5 & Il /
rder
Flow Direction .

graphic

The yellow boxes will briefly flash red as each step is executed. The Model progress box opens and the
progress bar indicates when the model completes. Note that ModelBuilder can be a bit finicky, and may
take a few runs to work correctly! Also note that, if the ModelBuilder fails midway through (e.qg. if the
model fails after creating the elevm file), you will either need to re-name any previously computer outputs,

or delete them using the Catalog panel.
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Model %

Processing 2 of 2

Done P
'\..-)

Executing (ASCI to Raster): ASCHToRaster Chpjruesshgiswr2016MEBEN\ES _data

Yelev.ase Chpjruesshgiswr2016NEBENEBa_project\Bx3_project.gdb elevm Float

Start Tirne: Wed Sep 14 10:42:47 2016

Succeeded at Wed Sep 14 10:42:48 2016 (Elapsed Time: 1.00 seconds)

Executing (Flow Direction): FlowDirection C\pjruesshgiswr2016\EBEWEB3_project

YWEx3_project.gdbhelevn Chpjruesshgiswr20L6WEBE\BS_project\B:3_project.gdb

Wlowdirm MORMAL Chpjruesshgiswr20168B3\EB3_project\ B3 _project.gdb
Ypercdropm

Start Time: Wed Sep 14 10:42:49 2016

Succeeded at Wed Sep 14 10:42:51 2016 (Elapsed Time: 1.89 seconds)

Verify that your files were created successfully in the Catalog pane. You may need to right click and
Refresh the Ex3Slope.gdb.

4 o0 Folders
4 g Bx35lope
Importlog

4 [ Ex3Slope.gdb
&= Aspect
B elevm
B FlowDir
EH FlowDirM
&= PercCrop
&= PerDropM
&= Slope

You can now add the outputs to the map and examine the results.

Save your Project to make sure you don’t lose what you’ve done.

mo)
In the model, use the Auto Layout tool in the ModelBuilder pane to organize the layout.

Add the Spatial Analyst - Surface - Slope tool to your model by dragging it onto the model window.
Connect the elevm output to this tool, specifying that it is the Input Raster for the Slope Tool.
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Slope

Add the Spatial Analyst 2 Surface = Aspect tool to your model connecting it to elevm as an input in a
similar way. Double click on the Slope and aspect tool outputs and specify file names for the outputs.

When setting names you need to be careful that you do not use a name of a grid that already exists, or else
you will get a yellow warning sign in the display as shown below and the model may not run.

(] " & Raster Creation
x
Slope (2) ! ﬁ\ﬂ Reclass
Blope [2} 1 P S S e T~ S
Slope

+ Slope (2) (Required) X
WARNING 000725 Slope (2): Dataset Chpjruesshgiswr20164\B3\B3_project

\Bx3_project.gdb’\Slope already exists,

=

Double click on the Slope tool and set the Output measurement to Percent_Rise. Your model should
appear as follows. If you have trouble adding the Slope or Aspect tools, it sometimes helps to save your
Project, close ArcGIS Pro, then open it again.
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Slope

ASCII to Raster

Finally add another copy of the Flow Direction tool to the model connected to take input from elevm and
set output flow direction and drop raster filenames. Set the flow direction type as DINF.

Flow Direction: Flow Direction (2) x
O l O .
, Flow Direction Parameters | Environments @
@ Input surface raster
O u |eIE\rm *| =~

Output flow direction raster
| slopedinfm | ™

[ | Farce all edge cells to flow outward
Output drop raster

| percdripdinfm | ™

Flow direction type

| DINF -
OK
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You can now click run and do all the processing required to import the data, compute Slope, Aspect, Flow
Direction and Hydrologic Slope at the click of a single button. Pretty slick!

But wait, there is more. You can set the model to take other inputs.

Right click on elev.asc and select Parameter.

Open...

Pararmeter ‘

Add Te Display -

Right click on each of the outputs flowDirm, percdropm, slopem, aspectm, slopedinfm, and
percdropdinfm, in turn and select Parameter and Add to Display.

ASCII to Raster

Flow Direction

&u

-]

Flow Direction

2]
4

A P now appears next to these elements in the diagram indicating that they are ‘parameters’ of the model
that may be adjusted at run time. Also note that by selecting “Add to Display”, the parameters that you
previously computed are now on the Map. Close your model clicking on Yes to Save.
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Elmap 2 ModE

ASCIl to R

Slope
“F
Model X
@ Save model?
Yfes Mo | | Cancel
or

Click on the model in the Catalog Project window and select Properties to rename it something you like

(e.g. FlowDirection).

4 HE Ex35lope.thx

EDDMG'

Add Te Analysis Gallery

Add To Favorites

View Metadata
#  Edit Metadata

I 5l Databases Open
> &R Styles Edit
4 [yl Folders
4 g B3Slo
u I
y B Ba Batch
v 5= B3 B Copy
b B asp| X Delete
b B eled
v B floy
b B flo
b BB flov EE' Properties

v B# percdrop

Properties

R percdropdinf Show properties for the tool.

Tool Properties: Model

General

Parameters

Mame

| FlowDirection
Label

| FlowDirection

Options
[] Set password
Store tool with relative ¢

If you go back to your model and now double click on it or right-click and Open it, you’ll see that the
input files are shown as parameters of the model just like when you execute a tool in Geoprocessing.
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Catalog Parameters | Environments

Project | Porta Favorites | | elev.asc
Ch\pjruessgiswr2016\BA\B3_data'elev.asc +
Search i flowdirm
flowdirm +
El Maps 1 percdropm
+
- Toolboxes percdropm
slopem
- ﬁi Ex35lope.thx slopem .
FlowDirection aspectm
aspectm +

Where you see warnings near one of your files, it usually either means that there is already a file of that
name in the place where you propose to put the output, or there is no input file. These can be resolved by
setting the inputs and outputs correctly.

If at some point you want to go back and modify your model you should open it to Edit and make the
changes you want.

4 g Toolboxes
- EEE:GSIDFIE

50 FlraseMirectinn

4 = Databe Open

— | Edit
I-G] Ex3!

You are done creating this model. Save your Project.

ModelBuilder is a very powerful way of creating complex analyses, and documenting your “workflow” in
a form that is visual and can readily be described. In this way, analyses that you’ve done can be passed on
to other analysts, and you can also use the visual palette display in your term project report or thesis to
document how you’ve done your analysis, so the visual aspect of the display helps with documenting your
work, as well as in organizing it.

To turn in: A screen capture of your final model builder model.

Close ArcGIS Pro.

We will now use this model for different data. Reopen ArcGIS Pro. Close the Map tab and add a new
map. Double click on your FlowDirection model in the Ex3 toolbox to run it. Locate the file demo.asc

extracted from the zip file of data provided at the beginning of this exercise to use as input. Set alternative
names for the parameter outputs.
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Geoprocessing 1 x

© FlowDirection

Parameters | Ervironments
elev.asc

ChUsershdt\ Desktop Ex3derno.asc
slopern

demoslope

aspectm
demoaspect

flowdirm
demoflowdir

percdropm
demopercdrop

slopedinfm
demoslopedinf

percdropdinfm
demopercdripdinf

Click Run and the model should generate results for each of the outputs and add these to the map. Turn off
the topographic basemap because the spatial reference information for this data is not consistent with the
web Mercator projection of the basemap. Examine the Raster Layer Properties > Source > Statistics
and record the minimum and maximum values associated with each of the outputs. If you don’t see
anything in your screen once this function is complete, right click on one of the new layers produced and
select “Zoom to Layer” and you’ll see the new information show up.

To turn in: A table giving the minimum and maximum values of each of the six outputs Slope, Aspect,
Flow Direction and Hydrologic Slope (Percentage drop) by D8 and Flow Direction and Hydrologic Slope
(Percentage drop) by DINF for the digital elevation model in demo.asc. Also turn in a screen shot of the
FlowDirDinf raster calculated using this model

Congratulations, you have just built a Model Builder geoprocessing program and used it to repeat your
work for a different (and larger) dataset. If you would like to save this tool to take to another computer or
share with someone else you can copy the file Ex3Slope.tbx from its location to a removable media to take
with you. If you are going to be sharing this tool more widely there are additional steps to take to clean up
the interface, label the input fields and write help documentation for it. Close ArcGIS Pro.
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Part 2. San Marcos Elevation and Precipitation

The purpose of this part of the exercise is to calculate average watershed elevation for subwatersheds of
the San Marcos basin, and to calculate average precipitation over each of these subwatersheds using
different interpolation methods. Average precipitation is then converted to a volume of precipitation and
compared to runoff volumes using a runoff ratio. This provides an insight into the annual water balance of
these watersheds, namely what fraction of precipitation is streamflow and what fraction is lost to
evapotranspiration and other losses such as infiltration and groundwater recharge.

The following data is provided in the Ex3Data.zip file:

SanMarcos.gdb file Geodatabase.
=RW | SanMarcos.gdb
o BaseMap
[E) Basin
(-] Gages
(=] PrecipStn
&) Subwatershed

There are the following feature classes:

- Basin. The San Marcos Basin feature class similar to that from exercise 2.

- Gages. The San Marcos Gages similar to that from exercise 2 that includes Mean Annual Flow.

- PrecipStn. PrecipStn contains mean annual precipitation data from precipitation stations in and
around the San Marcos basin downloaded from NCDC following the procedures given in
http://www.ce.utexas.edu/prof/maidment/gradhydro2005/docs/ncdcdata.doc. (The NCDC website
has changed so it is no longer possible to get this data this way. You can obtain NCDC data from
http://gis.ncdc.noaa.gov/map/viewer, but the process is somewhat tedious and requires processing
and waiting for email before delivery so we are providing data for you to use.) This data was
prepared by downloading all years of available precipitation data for the counties in and around
the San Marcos basin, then averaging over these years, retaining only those stations with 6 or more
years of annual total data reported by NCDC.

- Subwatershed. Subwatersheds delineated to each of the stream gages used in exercise 2
following the procedures that will be learned in a future exercise.

Note that in this geodatabase these feature classes have been projected to the
USA_Contiguous_Albers_Equal_Area_Conic coordinate system. It is generally better to do the sort of
hydrologic analysis done here involving volumes and areas in an equal area projection and | chose this
projection for this exercise.

1. Loading the Data

Open ArcGIS Pro and create a new blank project, Ex3_project. Click Connections in the Insert tab and
select Add Database
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PROJECT MAP INSERT | AN Select Existing Geodatabase

2] New Layout = iz Toolbox - © = @)|[E« GISWR2016 » B3 » Ex3Data » ¥

Iﬂ Import Map =% Add Folder

» | Project | = sanMarcos.gdb
Map~1* € cti - Task - :
ap~ 1] Connections == +1 Folders
¥
¥3 Add Database 1My Computer

Con i3  Mew File Geodatabase

*_-3 Mew Database Connection

to add the SanMarcos.gdb to the project. This is another way to associate a Geodatabase with a project.
In the Catalog pane you should see

4 |5 Databases
E’:} Ex3_Project.gdb
4 [ SanMarcos.gdb
4 [ BaseMap
Basin
[ Gages
(%] PrecipStn
Subwatershed

Right click on the BaseMap feature dataset and “Add To New Map”.
4 B SanMarcos.gdb

e ﬁ Basehi=» |
+  Add To New v [ Map
] Ga Mew v | & Map
=] Pre Import . J Add data to a new map.

You should obtain a map with all these features added. Note | changed the symbology a bit.
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== R ArcGIS Pro - Ex3_project - Map Feature Layer 7 — o %
Map Insert  Analysis  View Edit Imagery Share Appearance Labeling Data (0) dtarb (Utah State University) -~

00 ) 5Bk ED M0 O Atm T I

Axn E3¢ View Unplaced

Explore Bookmarks Basemap Add  Add | Sclect SelectBy Select By Infographics Measure Locate Convert To
- - -~ Data- Preset- | - Atiributes Location - - # Mare - Annotation
Clipboard Navigate = Layer Selection = Inquiry Labzling
Contents -1 x| i Canlog  [EREA i
= (i
7 : - Austin i
F [ search P - Swift
-

HO K/ 50l

Drawing Order

4[F] Map
' - .

[z Goges : 4 . J M{o L

@ " !

\ [ ]

4[] PrecipStn 7. X . \\,ﬂﬂ.\‘_;)“ﬁv‘_‘ \r

L] /}“ 2 :
4[] Subwatershed R

4 [/] Basin Camp ?J-a‘-.
O Bulls

Tepegraphic

San Antonio o

ni

mssor -] B FLE | 97.1052063°W 30.3008091°N

If you right-click on one these feature classes in the map legend, select Properties and scroll down until
you see Spatial Reference at the bottom of the layer properties, you’ll see that they have the NAD 1983
Albers coordinate system with the North American Datum of 1983. You should also see that the Linear
Unit is meters.

Layer Properties: Basin

General v Spatial Reference

Metadata

FrT Projected Coordinate System | MAD 1983 Albers
Elevation Projection Albers
Selection WEKID 0

Display Authaority

Cache Linear Unit Meter (1.0]
Definition Cuery False Easting 0.0

Time False Marthing 0.0
Range Central Meridian -596.0
Indexes Standard Parallel 1 29.5

Joins Standard Parallel 2 45,5
Relates Latitude Of Origin 37.5

Page Cuery

Geographic coordinate system GCS Morth American 1933
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If you move the cursor around on the map, you may see that the coordinates at the bottom are in degrees.
If you want them in meters, consistent with the coordinate system, right-click on Map and under
Properties & General = Display Units, select Meters.

Map Properties: Map

General
Mame Map
Extent
Metadata Map Units Meter
Elevation Surface Display Units Meters -
Coordinate Systern

Meters |

- r et Pefarcames reala

Zoom-to-Layer on the San Marcos Basin . Note that rather than displaying the negative coordinates
because the San Marcos Basin is West of the Central Meridian of this projection (96°W) and below the
Latitude of Origin (37.5°N) (and both the False Easting and False Northing are 0) W and S are used with
the coordinates to show this.

90,370.34W 848,847,365 m

We will use this specific NAD_1983_Albers projection, which is the USA Contiguous Albers Equal Area
Conic projection, for this exercise.

Go to https://livingatlas.arcgis.com/ and search for 'elevation’. You should see that one of the first entries
is 'Ground Surface Elevation 30 m' and if you read about this you see that this is 30m raster data extracted
from the USGS's National Elevation Dataset. We will use this DEM in this exercise, but loading it directly
from ArcPro.

Select Add Data to the Map

Imagery Share App
py [N
o N O

Add  Add Select Select By
[Data= Preset - - Attributes

*+ Data

Add data to the map.

And among the options presented, select Living Atlas.
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https://livingatlas.arcgis.com/

D) @)|[E > Portal » Living Atlas » * |©|| search Portat: Living Atlas Je
rganize * MNew ltem ¥ T O categories
= Project = Mame Type Date
o Databases T World Imagery Tile Layer 9/6/2

o Folders T World Topographic Map Tile Layer 9/6/2

{7 Portal 8 Warld Street Map Tile Layer 9/8/2
L‘I'S': My Content BH USA Topo Maps Tile Layer 1118/

& Groups & Terrain Imagery Layer &/20/
Al Dosial El World Traffic Service Map Image Layer 11710

@I‘s Living Atlas B National Geographic World Map Tile Layer 8/3/2

7.1 Computer ’ ‘DEEI World Transportation Tile Layer &1 5,.’

In the Search Portal: Living Atlas type in elevation and among the options presented, select Ground
Surface Elevation 30 m, the DEM identified in the web search.

Add Data x
@ @“:‘ﬂ Living Atlas » Search Result for 'elevation’ » - H')| | elevation X -
Organize * MNew ltem ~ — T EO Categories ~
4 [& Project = Marme Type Date =
ol Databases i Terrain: Elevation Tinted Hillshade Imagery Layer 6,/20,/201 SI

W Folders ) Ground Surface Flevation - 30m ] Imagery layer .. 2/13/2017

4 (7 Portal 8| TopoBathy Elevation Tinted Hillshad:  Imagery Layer 6/20/2015

fg‘: My Content & World Elevation GMTED Imagery Layer 11/4/2016

lf;b Groups B Terrain: Multi-Directional Hillshade Imagery Layer 6,/20/2018

&% Al Portal & Terrain: Slope in Degrees Imagery Layer 6,/20/2018

@I.’ Living Atlas & Terrain: Slope Map Imagery Layer 6/20/2018
4 E:| Computer & Terrain Imagery Layer EIEDHP_NST

Desktop 1 [ — >

o - Find more items...
Mame | Ground Surface Elevation - 30m | |Defau|t =
| Ok | | Cancel |

This data could also have been downloaded from the National Map viewer,
http://viewer.nationalmap.gov/viewer/, although the process is a bit more tedious. Here we are saving time
taking advantage of the Living Atlas data services.

At this scale your map likely appears very dark as Texas is at low elevation compared to the range of
elevation data in the US. Your map should look similar to the following:
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Save your Project document if you have not already.

Let's export data from this DEM to have a local copy to work with. First we need to define the area that
we want to work with. Let's pick an area that has a 2000 m buffer around the basin.

In the Geoprocessing Panel, use the search box to search on "buffer” and select the Buffer (Analysis) tool.

Buffer (Analysis Tools

Creates buffer polygons around input features to a specified distanc

Set the inputs as follows and Run the tool.

26



Geoprocessing » X
© Buffer =

Parameters | Environrents

Input Features

Basin - e

Output Feature Class

ssktophEx3\SanMarcos.gdb'\BaseMap!BasinBuffeq

Distance [value or field] Linear Unit -
2000 |Meters -

Side Type

Full -

Method

Planar M

Dissolve Type

Mo Dissolve M

Note that | saved the result in the San Marcos.gdb Basemap feature dataset.

The result should be a polygon that is 2000 m larger around the edge of the basin. If necessary, use the
Symbology tool to change the Buffer symbology to an Outline and then you can see the other feature
classes underneath it.

= ] ArcGIS Pro - B3 _Project - Map Feature Layer ? — o %
Map Insert Analysis View Edit Imagery Share Appearance Labeling Data () dtarb (Utah State University) =~

wD o St ma BB M B N W ALE B 8 &

History Python ModelBuilder Environments Tools Ready To Feature  Raster Spatial Intersect Union Buffer Near Network Geostatistical Raster  Function
Use Tools~ | Analysis~ Analysis~ Join =| Analysis=  Wizard | Functions Editor
Geaprocessing & Portal Tools Raster Data Intera...
Contents ~ 1 x Catalog [ Map X - Geoprocessing ~ 1 x

T | seareh » ® Buffer

EG M7 & &I

Parameters | Environments

Input Features

Drawing Order Basin it
4[] Map i, Qutput Feature Class
o +
2 7] Gages BasinBuffer
Distance [value or field] Linear Unit -
4[] PrecipStn 2000 | |Meters -
. Side Type
4[[7] BasinButter Full d
Method
] Planar -
4[] Subwatershed Dissolve Type
No Dissolve -
4[] Basin
4[] NED30m
Value
8700
. 450 Buffer

Completed successfully

T hi
‘opographic Catalog  Symbology | Geoprocessing
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Use the search box to search on "clip" and select the Clip (Data Management) tool. This tool was chosen

because one of its allowable inputs is an image service.

Geoprocessing - I x

(_—J' u:Iip| w o
Search Results (13)
*, Clip (4nalysis Tooks

*, Clip (Data Management Tooks

Clip (Data Management Tools)
Cuts out a portion of a raster dataset, mosaic dataset, or image service layer.

~ | Geoprocessing

_ {E::I

Clip

Parameters | Environments

Clip (Data Management Tools) x

Cuts out a portien of a raster dataset, mosaic dataset, or image service layer. # Input Raster

Output Bxtent

* Rectangle
-

3
* Output Raster Dataset

NoData Value

Set the inputs as follows (setting the output to go into SanMarcos.gdb) and Run the tool.
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Geoprocessing > 1 x
® Clip =

)

Parameters | Environmeants

Input Raster

| Ground Surface Elevation - 30m "’l
Output Extent

| BasinBuffer v|
Rectangle S

<[ -253442.119935468 | =|-131759.203299107 |
8| -1220479.20505731 | 4|-1144129.96424694 |

[ | Use Input Features for Clipping Geometry

Output Raster Dataset
|::\U sers\dt\Desktop\Ex2\SanMarcos.gdb\smdem| |

MoData Value
| -3.402823e+ 28 |

[ | Maintain Clipping Extent

You should have a raster layer added to your ArcMap with a local subset from the DEM, that has the
extent of BasinBuffer and is easier to symbolize. Turn off the Gages, PrecipStn and Ground Surface
Elevation layers to see this display.

B EgEe-c- s Arc6IS Pro - B3_Project - Map Raster Layer ? — o X
: Map Insert Analysis View Edit Imagery Share Appearance Data () David (Utah State University) = L1~
2 i 2 = G Co
cut g @ U!] & HE & @ % FB] =l Attributes £ Pause =5 E 7 Sync
&1 Copy e T lE) Lim Clear s % View Unplaced sk Remor
Copy A 1 Clea place: emove
Paste Explore Bookmarks Go  Basemap Add  Add  Select Select By Select By Infographics Measure Locate ConvertTo  Download
- Copy Path | [Jisi € - ToXY - Data- Preset~ - Attributes Location - - £ More - Annotation  Map~
Clipbosrd Mavigate. 5 Layer Selection A Inquiry Labeling Offline
Contents + I x| i Catalog  |[E]Map . ~ Symbology - smdem el
= 122R Reund Rock
T ‘Searth b | 22114 smdem =
=G K /A EE{- @ |l + i Primary symbology
Gille'spn
Tiailh |+ |stretch
. Bran Austin
Drawing Order v Camp
Bl
v
4[] Map . . : Color ramp
4[] Gages Band Band.1 ~
. e Corschere [ -|
4[] PrecipStn
Value 674116 61842
®
Label
4[] BasinBuffer A [BrATI C1848]
| 20430 v Background
&y Basm [ Display background value
O o |
4[] Subwatershed
Nodata
4[] smdem | | Meang v Stretch
Value _—
. Stretch type -
n . : BORIEY e i [10 ‘
674116 - /San Antonio L —
4[] Ground Surface Elevation - 30m ¥ T i 3 b | Statistics Dataset -
Value 1 o =4
8700 =]
o P . 4 o : i Options.....T. x
. e v (1952704 -] BxE) 95,534.60W 832,335.71S m 7 Selected Features: 0 | I | & | "Hlement. Catalog - Geaprocessing | Symbalogy
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If you examine the Layer Properties for Source ->Raster Information for this you will see that it has a
cell size of 30.92 m and North America Albers Equal Area Conic spatial reference. This is the
resolution and coordinate system of the data as obtained from the ArcGIS elevation image service. If you
look at its spatial reference, you’ll see it has the same projection type (Albers) and Geographic Coordinate
System (NAD83) but the projection parameters are different from those of the BaseMap feature dataset for
the San Marcos Basin that we’re working with. These parameters are appropriate for display for all of
North America, not just for the continental US.

Layer Properties: smdem X
General ! ;&
Erera | v Spatial Reference
Metadata
Projected Coordinate System  Morth America Albers Equal Area Conic
Source
Elevation Projection Albers
Cache WEID 102008
laoins Authority Esri
Relates Linear Unit Meter (1.0
False Easting 0.0
False Morthing 0.0
Central Meridian -596.0
Standard Parallel 1 20,0
Standard Parallel 2 &60.0

Latitude OF Origin

Let’s add streams from NHDPIus for visualization. In exercise 2 you produced should have extracted a
subset of the NHD Plus Flowline dataset into your Exercise 2 Geodatabase. Let’s add this to the map.

Select Add data

+ OO0
om K B Uy
r[ Add  Add Select Select By Select By

e

utes Location

+ Data jon

Add data to the map.

In the Add Data window navigate to the geodatabase from Exercise 2 and choose Flowline
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Add Data b4
@ @“E * Computer ¥ Desktop II.ExE » Exercise? ¥ Exercise2gdb » SanMarcos ‘I v|'ﬂ,.‘-'|
Organize * MNew ltem ~ b g T
A| = Project |‘ Marme Type Date
i5l Databases Basin File Geodatabase F
5 Folders Catchment File Geadatabase F
4 (A Portal Catchmentsh File Geodatabase F
@ My Content Flowline File Geodatabase F
ﬁ Groups I zages File Geodatabase F
5 Al Portal Subwatershed File Geodatabase f
@ Living Atlas
4 [{3 Computer
i Desktop
(==, Ty, v »
Mame | |Default -
| | | Cancel |

Dripping
Sorinas

This should add the flowlines from Exercise 2 into your
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2. Projecting the DEM

It is desirable to work with data in consistent coordinate systems. Let's project this DEM into the same
projection as the BaseMap Feature dataset provided (as we noted above the DEM from the web service
was in a slightly different coordinate system). Open the Toolbox and open the tool Data Management
Tools = Projections and Transformations - Raster - Project Raster. If you find this tool hard to
locate,

4 .o Projections and Transformations
4 L. Raster
o

Flip

Firror

Project Raster

you can also search for it:

=t Talaa a=ixlala
WU A0 T

(_-' project raster X

JEArCN RESUILS |OL

*.. Project Raster [Dztz Mznzgement Took

Set the inputs as follows to produce a projected raster ProjDEM in SanMarcos.gdb geodatabase with 30m
cells and the NAD 1983 Albers projection. Note that the NAD 1983 Albers projection is most easily set
by clicking next to Output Coordinate System and selecting from existing Layers on the map.
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Geoprocessing v X

Coordinate System

{{_} Prﬂj ect Ra ster E Select the Coordinate System to view the available options.
Current XY Details Current Z
Parameters | Ervironments @ <None>
Input Raster XY Coordinate Systems Available | Search ad | bl
smdem ~| ok
- - 4 |Layer~s
sers\dt\Desktopgiswr2017\Ex3\5anMarcos.gdb\ ProjDEM| b | @ NAD 1983 Albers

Cutput Coordinate Systern

MAD_1983_Albers 1 @ WGS 1984 Web Mercator Auxiliary Sphere

@

eographic franstormation I* Geographic coordinate system

I* Projected coordinate system

€sampling lecnnigue
Cubic convolution

Registration Point
X Y

The result should appear similar to:

The spatial information about ProjDEM can be found by right clicking on the ProjDEM layer, then
clicking on Properties = Source = Raster Information, and Statistics
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v Raster Information

Columns

Rows

Mumber of Bands
Cell Size X

Cell 5ize ¥
Uncompressed Size
Format

Source Type

Pixel Type

Pixel Depth
MoData Value
Colormap
Pyramids
Compression

Mensuration Capabilities

v Statistics

Band Name = Minimum

4227

2745

1

30

30

44,21 MB
FGDER
Elevation
floating point

32 Bit

absent

level: 5, resampling: Mearest Meighbor

LFFY

Basic

M axdirmum

Build Parameters: skipped columns: 1, rows: 1, ignored value(s): Mone

Band_1 68.761843449707 | £18.531138596484 | 259.20536895443

116.28632131283

To turn in: The number of columns and rows in the projected DEM. The cell size of the projected DEM.

The minimum and maximum elevations in the projected DEM.

3. Exploring the DEM

Change the symbology of the ProjDEM layer.

Drawing Order

4[] Gages
*

4 [] PrecipStn
.

Pl BasinBuffer

4 [J] ProjDEM

v Color ramp
Band Band_] =
Colorscheme | R -|

Value 69.7618 618,531

Label | 69.761348449707 | 612.5311880648+|

v Background

Val
e [] Display background value
l £18.5311289642844 ‘—|
Li]
69.761848449707 Mot
F NED30m_Clip
\ﬂ"e v Stretch
61848
Stretch type ‘Mmlmum Maximum *
. 674116

34




To explore the highest elevation areas in your DEM select Spatial Analyst Tools > Map Algebra >
Raster Calculator.

o Spatial Analyst Tools
£ Conditional
= Density
£ Distance
£ Extraction
£ Generalization
£.- Groundwater
=8 Hydrology
&q Interpolation
£ Local

4a &5 Map Algebra

*_ Raster Calculator

Double click on the ProjDEM layer with the DEM for San Marcos. Click on the greater than “>” symbol
and select a number less than the maximum elevation. This arithmetic raster operation will select all cells
with values above the defined threshold. In the example below a threshold of 600m was used.

Geoprocessing -~ 1 x
© Raster Calculator =
Parameters | Ervironments \ ':? /

Map Algebra expression

Rasters * Tools
ProjDEM - -
srdem >
MED30m <
‘=
o= ¥
"ProjDEM" > 588 A
b
Output raster
ProjDEMEDD +

A new layer appears on your map. The majority of the map (pink color in the figure below) has a 0 value
representing false (values below the threshold), and the lime-green region has a value of 1 representing
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true (elevations higher than 600 meters). If necessary, change the symbology of the resulting map display
so that you can see high elevation areas more clearly and zoom in on them.

Use the raster calculator again (with elevation 618 meter threshold) and the explore tool to identify the grid
cell of maximum elevation in ProjDEM. Take a screen shot similar to the below and indicate the grid cell
with the highest elevation

~

Note that the above label was placed on the screen shot using a word processor. This is a bit easier than
fiddling with labels in ArcGIS.

To turn in: A screen shot showing the location of the highest elevation value in the San Marcos DEM.
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4. Contours and Hillshade

Contours are a useful way to visualize topography. Select Spatial Analyst Tools - Surface - Contour.
Select the inputs as follows, with a 10m contour interval:

Geoprocessing v i X

€ Contour =

Parameters | Erwvircnments

Input raster
ProjDEM -
Output feature class
Contours
* Contour interval 10|

Base contour

7 factor 1

Contour type
Contour -

A layer is generated with the topographic contours for San Marcos. Notice the big difference in Terrain
Relief to the west of the basin compared to the east. This results from the fact that the Balcones fault zone
runs through the middle of this basin, to the west of which lies the rolling Texas hill country and to the east
the flatter coastal plain. There is a tower located in the City of San Marcos on which you can stand and
see these differences in topography to east and west!
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Another option to provide a nice visualization of topography is Hillshading.

Select Spatial Analyst Tools > Surface - Hillshade and set the factor Z to a higher value to get a
dramatic effect and leave the other parameters at their defaults (the following hillshade is produced with a
Z factor of 10). Click OK. You should see an illuminated hillshaded view of the topography.

Geoprocessing -2 x
- -.4
@ Hillshade =
Parameters | Ervironments @
Input raster
| ProjDEM -
Output raster
| Hillshade |
Azimuth | 31|
Altitude | 43|
|:| Model shadows
Z factor | 113”

38



To turn in: A layout with a depiction of topography either with elevation, contour or hillshade in nice
colors. Include the streams from NHDPIlus and Basin and sub-watersheds from the SanMarcos.gdb

Basemap feature dataset.

5. Zonal Average Calculations

In hydrology it is often necessary to obtain average properties over watersheds or subwatersheds. The
Zonal functions in Spatial Analyst are useful for this purpose. If you rearrange the map display as shown
below and label the Subwatersheds with the attribute HydrolD, you’ll see that there is a unique

Subwatershed for each stream gage location.

Contents - B %

T 2]
=8 K/ B & |l

Drawing Order
A Gages
L]
4 [] PrecipStn
L]
4 [ ] Contours

4[] Subwstershed

8

4 Basin
4 [7] ProjDEM

Value

! 618.531188964844

[E=[ Map X

Label Class -3 X

Subwatershed - Class 1
Class ~ | Symbol | Position

&)

Parser EfEScript L ‘

Fields T Text Functions
OBJECTID ~1[ cintg -
HydrolD '| Cdbl() W
Insert Values vi
Expression [] Advanced
[HydroID]

e v =

Use coded value descriptions
[/] Rernove extra snace

Select Spatial Analyst Tools > Zonal > Zonal Statistics as Table. Set the inputs as follows:




Geoprocessing » X
ot O =4
&) Zonal Statistics as Table =
Parameters | Ervironments 7
Input raster or feature zone data
Subwatershed v .
Zone field
HydrolD -
Input value raster
ProjDEM -
Output table
zsktop!Ex3\Ex3_Project\Ex3_Project.gdb\zoneeley
lgnore MeData in calculations
Statistics type
All v

Click OK. A table with zonal statistics is evaluated and added to the map (at the bottom of the map
display). Right-click to open the table.

= zoneelev X

Field: E Mew E Delete @Calculate Selection: t[r@ Switch

4 OBIECTID | HydrolD COUMT = AREA MIN MAX RAMNGE MEAN STD SUM

I 1 330 323069 290762100 133912979 271534399 13772142 189.860326 25141791 61337985.784241
2 331 1023367 921210300 243430069 616406372 372976303 418.479394 80454873 428341697.464828
3 332 165683 149114700 1866521 4024935 2155414 285.565955 40668827 47810473.124252
4 333 140798 126718200 173.553955 392025085 21847113 266.105394 43421187 37467107.250351
5 334 579142 5212727800 98129776 214013489 115883713 151936372 22415665 87992734.571007
6 335 1089142 980227800 98632591 410.593994 311961403 183.533981 51.065948 199894567.148315

This contains statistics of the value raster, in this case elevation from ProjDEM over the zones defined by
the polygon feature class Subwatershed. The Value field in this zone table contains the HydrolD from the
subwatershed layer and may be used to join these values with attributes of the Subwatershed feature class.

Right click on Subwatershed and select Joins and Relates - Add Join.

40



4 Subwatershed
0O |& Cory
e Basir &= Remove

O

4 [] Contl [ Attribute Table

Design
[] Basit
4 Hillst loins and Relates » |ER AddJoin

Select HydrolD as the field in this layer (Subwatershed) that the join will be based on, zoneelev as the
table to join to this layer, and HydrolD again as the field in the table to base the join on.

Geoprocessing » X
© Add Join =
Parameters | Ervironmarts 7
Layer Marne or Table View
Subwatershed -
! Input Join Field
HydrolD -
Join Table
zoneeley -
Output Join Field
HydrolD -

Keep All Target Features
Note the warning, which states: “The join field HydrolD in the join table Subwatershed is not indexed. To
improve performance, we recommend that an index be created for the join field in the join table.”

This warning can be ignored for this particular dataset because this table is sufficiently small, so the
presence of indices to speed up the data queries does not make any noticeable difference.

Open the Subwatershed attribute table and scroll across. You’ll see the statistics have been added to the
attributes that this feature class already held.
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ArcGIS Pro - Ex3_Project O *

# Subwatershed X -

Field: E Add ;ﬁ Delete E Calculate | Selection: .QEE‘ Switch =
4 SitelD SiteName OBJECTIDY  HydrolD COUNT  AREA MIN MAX RANGE MEAN STD SUMm

IQTS 08172400 Plum Ck at Lockhart, ... 1 330 | 323060 200762100 |133.912979 |271.634399 | 137.72142 |189.860326 |25.141791 | £1337985.784241
131 08171000 Blanco Rv at Wimber... 2 331 | 1023567 921210300 243.430060 616.406372 372976303 418.479394 80.454873 428341697.464328
933 08171300 Blanco Rv nr Kyle, T 3 332 | 165683 149114700 | 186.6521 | 4024835 | 2158414 |288.565055 |40.668827 & 47810473.124252
954 08170500 San Marcos Rv at San... 4 333 | 140798 126718200 |173.553955 392.025085 | 218.47113 |266.105394 |43.421187 | 37467107.250351
962 | 08173000 Plum Ck nr Luling, Tx 5 334 | 579142 (521227800 | 98129776 |214.013489 |115.883713 |151.936372 |22.415665 | 87992734.571007
936 08172000 San Marcos Rv at Luli... 6 335 | 1089142 930227800 | 98.632591 '410.593994 |311.961403 |183.533981 |51.065048 199894567.148315

Click to add new row.

W

-
E 0 of 6 selected Filters: - | + 100% -

In the Geoprocessing panel, select Table to Excel and specify Subwatershed as the input Table, and
SubwatershedStats as output Excel file.

Geoprocessing - 1> Geoprocessing - 1 x
@ [iableto exce ]2 @ Table To Exce =
Search Results (66) ) B
[E] Table To Excel (Conversion Tocks Parameters | Environments (2
Input Table
Subwatershed -| &
Output Excel File
CAGISWR201 6% Ex3 SubwatershedStats.xls +

[] Use field alias as column header

[] Use domain and subtype description

If you open up the resulting SubwatershedStats Excel file you’ll see the descriptive statistics there for the
San Marcos subwatersheds.

Determine the mean elevation and elevation range of each subwatershed in the SanMarcos Subwatershed
feature class.

To turn in: A table giving the HydrolD, Name, mean elevation, and elevation range for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
elevation? Which subwatershed has the largest elevation range?

6. Calculation of Area Average Precipitation using Thiessen Polygons

Now to do something really useful. We will calculate the area average mean annual precipitation over the
watershed using Thiessen polygons. Thiessen polygons associate each point in a watershed with the
nearest raingage. Turn on the PrecipStn stations in the map display and open their attribute table. You’ll
see an AnnPrecip_in attribute which is the mean annual precipitation at each gage in inches.
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T Switch =

. s e ¢ ELEVATIOM = ELEM Myr  AnnPrecip_in
. 2006 TPCP 24 35175
1463 TPCP 6 34315

¢ 5334 TPCP 19 32.607368
1183 TPCP B 30.798333

. 4176 TPCP 25 3538844

3353 TPCP 20 35,657

3048 TPCP 17 39.082353

045 TPCP 10 37.358

. 4374 TPCP 1 38.551818

Select the tool Analysis Tools = Proximity = Create Thiessen Polygons

a Analysis Tools
£ Extract
{1 Overlay
£ Pairwise Overlay
a & Proximity

*.. Buffer

|; Create Thiessen Polygons |

Specify PrecipStn as the Input Features. Save the output feature class in the BaseMap feature dataset and
indicate that ALL fields should be output. By saving to the BaseMap feature dataset you ensure that the
Thiessen polygon feature class inherits the spatial reference information from this feature dataset, keeping
all your work in a consistent spatial reference. Click OK. It's really important that you select “All” here to
carry the attributes of the Precipitation stations to the polygons associated with them.

Geoprocessing X
@ - =
&) Create Thiessen Polygons —
Parameters | Ervironments 7)

Input Features
PrecipStn - il

Output Feature Class
thiessenpaoly

Output Fields
All fields -

The result is a Thiessen polygon feature class. This tessellates the landscape into regions that are closer to
a particular gage than to any other.
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Here is what your attribute table should look like for thiessen polygons. If it doesn’t have all these
attributes at the right hand end, delete the result you just computed and do it over with the ALL option
selected to make sure you transfer all the attributes from the gages to the polygons.

Field: E New ﬁ Delete ﬁ; Calculate

.4 OBIECTID | Shape

Il Polygon
2 Polygeon
3 Polygon
4 Polygeon
5 Polygon
(3 Polygon
7 Polygon
8 Polygon
9 Polygon
10 Polygon
1 Polygon
12 Polygon
12 Polygon
14 Polygon
15 Polygon
16 Polygon
17 Polygon
18 Paolygon

Shape_Length
219160.88469
180867.160187
115197.971824
144172.839934
122727.252192
109158.064602
77451 84468
89625.580912
131274279442
164610.415862
12527458415
98482.889825
144148.611523
99985.574528
135071.554432
121607.561971
111466.266672
104164.265515

Selection:

Shape_Area
2743248246.425552
1912782695.771555
721528046.483713
1126878591.586405
994385367 29268
742107271.512506
352989955.07953
429818644.007928
1012438076.842714
1717347186.543875
§34148826.022078
579456544.809058
1227871182.469280
549126330.644352
046265922.719634
788948118.508672
754447386.159967
674860878.823766

7% Switch
Input FID  COOPID
6 411215
27 418187
15 413622
29 418415
2 410429
32 419815
28 | 418358
31 418877
1 410428
1 412820
24 416276
21 414805
18 414575
16 413624
8 411671
4 410660
23 415430
2 415285

stname
BULVERDE
SEGUIN 1 S5W
GOMZALESIN
SMITHVILLE

AUSTIN-BERGSTRO...

WIMBERLEY 1 NW
SISTERDALE
TEAGUE RANCH

AUSTIN MUELLER M...

ELGIN

MEW BRAUNFELS
KINGSBURY
JEDDO 35
GOMNZALES10 SW
CHEAPSIDE
BELMONT
LULING 12 NE
LOCKHART 2 SW

latdd

2975
29.55
29533333
30.016667
30183333
30
29983333
30433333
30316667
3035
29733333
29683333
29.766667
29433333
29316667
29516667
29833333
2985

longdd

-98.45
-97.966667
-97.45
-9715
-97.683333
-98.066667
-98.733333
-98.816667
-97.766667
-97.366667
-98.116667
-97.766667
-97.316667
-97.516667
-07.35
-97.683333
-87.566667
-97.7

ELEVATION = ELEM
3353 TPCP
1533 TPCP
1158 TPCP
1036 TPCP
1463 TPCP

253 TPCP
426.7 TPCP
4968 TPCP
2006 TPCP
176.5 TPCP
2164 TPCP
1554 TPCP
1265 TPCP
1113 |TPCP

945 TPCP
1183 TPCP
1356 TPCP
1494 TPCP

[}
pal
1
25
24
26
17

pa

10

10

AnnPrecip_in
35657 |
35712857
35.1448
36.1115
34.515
4047618
40497273
32.5052
35175
35.094231
34.270588
38.788571
38.240952
37571111
37358
30.798333
36.803
36125

If you rearrange the map display you can get a map looking something like the below. What we’re going
to do is to find the area of each thiessen polygon that overlays each subwatershed. This is done using the

Intersect function, one of the most powerful functions of spatial analysis.
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To average precipitation values in these polygons over the subwatersheds we need to intersect the thiessen
polygons with the subwatersheds and compute area weighted averages for each subwatershed. The
following calculations achieve this.

First right click on the Subwatershed layer and remove all joins (to remove the join with zonelev that we
created earlier).

Subwatershed
O ) Cory
thiessenpoly Ex Remove

[] Contours EE  Attribute Table
Design b
[] BasinBuffer
[ Hillshade Joins and Relates k E Add Join
Value |, Create Chart b @ Remowve Join
254 Remowe All Joins
|| 0, Zoom To Layer B3

Use the search window to locate the Intersect (Analysis) tool and set the inputs as follows
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Geoprocessing * X

© Intersect =
Parameters | Ervironments (7
Input Features -Zl{fjl Ranks
Subwatershed -
thiessenpoly -
Output Feature Class
thiessen_sub_intersect
Attributes To Join
All attnibutes -
XY Tolerance
Meters -
Output Type
Same as input -

Following is the result, the thiessen_sub_intersect polygons symbolized with COOPID as the Unique
Value field — this is the identifying number of the rain gage in the cooperative program by which
volunteers supply precipitation data from their gages to the National Weather Service.

410660

418187
418358
418544
419815

410832

Contents L7 x| IR thiessen sub intersect ~ | Symbology -1 x
— " 7 \ 7 T Symbology
= = | E E_ | / | y gy
LA \ ® \ \ Unique Values
@ LI. . b J,-/ 3 |‘
~ /S e \
— \ ~ / | . Value field
Drawing Order 4 \ T M a
\ L]
A ° A 7 e 7 . j Field 1 |COOPID
4 [7] thiessen_sub_intersect i \ / . N \ - -
P e / \ . - Add field
. . - { \ -
[ 410429 < bl g N~
1 210509 Color scheme
] 410832 . 29
= = "+ + § More -
3 211429 g
413136 Symbe Value
O 214402 N
O #4757 ~ [coorD 16 v
] 414805
[] 415285 SIEE
[ 415430 410509
] 216276

411429

If you open the ThiessenSublntersect attributed table you will see that from the 6 subwatersheds there are
now 24 polygons, each contributing to part of a subwatershed and associated with a single rain gage. Let
Py denote the precipitation associated with each rain gage and Aix the area of intersected polygon
associated with rain gage k and subwatershed i. Then the area weighted precipitation associated with each
subwatershed is
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p = ZkAikPk
YA

Open the attribute table for the intersected thiessen polygons and add a new field to the table, APProd.

FH zoneelev b

Field:| 55 Add EDHE‘E g Calculate | Seleci

o~ s T
"|1— Add Field

Add a new field in this table.

2

Double-click on the greyed-out “Data Type” column, where it says Long, and change the Data Type of
APProd to Float. If you don’t change this data type, your calculations will fail on a datatype mismatch
error.

EH thiessen_sub_intersect e Fields: thiessen_sub_intersect X

Current Layer thiessen_sub_intersect

4 Visible [M] Read Only Field Name Alias Data Type [] Highlight MNumber Format Domain Default Length
O HydrolD HydrolD Long O Mumeric
| SitelD SitelD Text O 10
O SiteMame SiteMame Text O 50
O FID_thiessenpoly  FID_thiessenpoly  Long O Mumeric
O Input_FID Input_FID Long O MNumeric
O COOPID COOPID Double [l Mumeric
O stname stname Text O 254
O latdd latdd Double O MNumeric
O lengdd longdd Short O MNumeric
O ELEVATION ELEVATION Long O MNumeric
O ELEM ELEM ‘ O 254
O Myr Nyr Double O Mumeric
O AnnPrecip_in AnnPrecip_in Date O MNumeric

Text

Shape_Length Shape_Length Elob O MNumeric
Shape_Area Shape_Area Guid O MNumeric
O APProd ong  w O

Make sure to save your changes using the save button in the Fields tab at the top of the screen.

FIELDS INSERT AMALYSIS VIEW SHARE

B 5

Domains Subtypes

Filter Mame:

Filter Domain:

Design Filter

Go back to the thiessen_sub_intersect polygon attribute table and right-click on the header of APProd,
selecting “Calculate Field”.
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Selection: .‘rc@ Switch =
| _aiessenpoly  Input FID  COOPID | stname latdd longdd ELEVATION ELEM Nyr  AnnPrecip_in Shape_Length Shape_Area APProd |
—
I 5 2 410429 AUSTIN-BERGSTRO.. 30183333 -97.683333 1463 TPCP 6 34515 51277805967 77506679.322343 <Nul 2+ SortAscending
6 32 419815 WIMBERLEY 1 MW 30 -98.066667 253 TPCP 21 4047619 34427447989 44018977 209083 <MNu E"' Sort Descending
18 22 415285 LOCKHART 2 SW 29.85 -97.7 1494 TPCP 10 36125 67155210013 16825434346856 <MNu| T Custom Sort..
6 32 419815 WIMBERLEY 1 NW 30 -98.066667 253 TPCP 21 4047619 66821259515 120874333.043417 <MNu =
Bﬁ Calculate Field
7 2 | A1RIRR  CISTERMAIE 70087771 -0R 723373 AT TDrD 11 ANAGTITY | WA RAAIME | FIITAART RN0T0 | o

Create the expression !AnnPrecip_in! * IShape_Area! and click Run.

Geoprocessing v B X
®© Calculate Field =
Parameters | Erwironments ]
Input Table =
| thiessen_sub_intersect '|
Field Mame
|Apprnd '|
Expression Type
| Python 3 -
Expression
Fields T Helpers T
longdd - .conjugate() -
ELEVATION .denominator() I
ELEM imag(Q
Nyr .numerator()
AnnPrecip_in real()
Shape _Length .as_integer_ratio()
Shape_Area fromhex()
Approd * || hehl =
|Insert‘u‘a|ues -l * J o+ - =
e
|!.ﬂnnF‘r‘ecip_in! * 15hape_Area! :|
L4

The result is a new field with the numerator terms for the equation above. Now locate the column
HydrolD. These are unique identifiers for each Subwatershed. Right click on the header and select

Summarize
Hydre™ | ciem1m Cotblog
:‘%4- Sort Ascending :

:Ei- Sort Descending
3 $ Custom Sort...

B Calculate Field

1 Ef Summarize
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Carefully select the summary statistics you need. | selected the following: SiteName - First, Shape_Area -
Sum, APProd — Sum, and the HydrolD Case field. Click Run.

Geoprocessing -1 x
© Summary Statistics =
Parameters | Ervircnmerts 7
Input Table
thiessen_sub_intersect -

Qutput Table
thieszen_stats

Statistics Field(s)

Field 'i\_':' Statistic Type
SiteMame - || First v
Shape_Area || Sum -
Approd =|| Sum -

- P
Case field ()

HydrolD -

Navigate to your output table, and you’ll see that the resulting table gives the numerator and denominator
in the equation above for each subwatershed.

FH thiessen_sub_intersect FEEI Fields: thiessen_sub_intersect m

Field: E Mew ﬁ Delete E Calculate | Selection: r,trﬂ Switch
4 OBIECTID | HydrolD FREQUEMNCY FIRST_SiteName SUM_Shape_Area  SUM_APProd
Il 330 3 Plum Ck at Lockhart,... 290769999,999987 10574586624
2 331 9 Blanco Rv at Wimber... 921160000.000129 34543450746
3 332 1 Blanco Rv nr Kyle, Tx  149159999.999961 6037428736
4 333 1 S5an Marcos Rv at San... 126659999.999955 5126714368
5 334 3 Plum CknrLuling, Tx  521279999.999982 19037601459
] 335 7 5an Marcos Rv at Luli.. 980249999.9998458 36849504638.5
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Add a New field SubW_Precip_in to this table, again as a Float, and Save the result.

B thi essen_sub_intersect ﬁ thiessen_stats =u Fields: thiessen_stats X

Current Layer |thi essen_stats

4 []Visible [W] Read Only = Field Name Alias Data Type
OBJECTID QBJECTID ObjectID
(| HydrolD HydrolD Leng
O FREQUENCY FREQUENCY Long
| FIRST_SiteMame FIRST_SiteMame Text
O SUM_Shape_Area SUM_Shape_Area Double
(| SUM_APProd SUM_APProd Double
O ISubW_Precip_in SubW_Precip_in  Float I

Go back to the thiessen_stats table and right click

PEEI Fields: thiessen_stats

Selection: (7% Switch
R5T_SiteMame SUM_Shape_Area SUM_APProd i‘; e :
um Ck at Lockhart,... 290760999.500087 10574586624 2¥ Sort Ascending
anco Rv at Wimber... 921160000.000120 34843450746 A% Sort Descending
anco Rv nrKyle, Tx  149150999.599961 6037428736 T Custom Sort..
n Marcos Ry at 5an... 1266059%99.9%9935 3126714368 @ Calculate Field
am Ck nr Luling, Tx  521279999,999982 19037601459 B summarize
n Marcos Ry at Luli... 980249%99.9%9348 36349504638.5

BBy Fields

and use Calculate Field to evaluate this as 'Sum_APProd! / 'Sum_Shape_Area!
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Geoprocessing 1>

© Calculate Field

Parameters | Ervircnments

Input Table
thiessen_stats -
Field Mame
SubW _Precip_in -
Expression Type
Python 3 -
Expression
Fields T Helpers T
QBIECTID «conjugate()
HydrolD .denominator()
FREQUEMCY Jimagf()
FIRST_SiteMame .numerator()
SUM_Shape_Area real(]
SUM_Approd .as_integer_ratio()
SubW_Precip_in fromhex()
hewl
Insert Values | * 7 o+ - =

SubW_Precip_in =

'SUM_Apprad! / !SUM_Shape_Area!

The result is the precipitation in inches for each subwatershed. This is pretty cool! And you can see how
the tools in ArcGIS can give you a spatially area-weighted result that would be more tedious to derive
otherwise.

To turn in: A table giving the HydrolD, Name, and mean precipitation by the Thiessen method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation?

7. Estimate basin average mean annual precipitation using Spatial
Interpolation/Surface fitting

Thiessen polygons were effectively a way of defining a field based on discrete data, by associating with
each point the precipitation at the nearest gage. This is probably the simplest and least sophisticated form

of spatial interpolation. ArcGIS provides other spatial interpolation capabilities in both the Spatial Analyst
and Geostatistical Analyst Toolboxes. Following are the interpolation tools in each.
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4 Spatial Analyst Tools 4 Geostatistical Analyst Tools

£ Conditional 4 iWInterpolatinn

£ Density *.. Diffusion Interpolation With Barriers

&7 Distance “. EBK Regression Prediction
£ Extraction *.. Empirical Bayesian Kriging

Global Polynomial Interpolation

. IDW

P . .
=7 Generalization

& Greundwater
£+ Hydrology Kernel Interpolation With Barriers
4 £ Interpolation Local Pelynomial Interpolation
“ IDW Moving Window Kriging

“

Kriging Radial Basis Functicns

“.. Matural MNeighbor
Spline

Topo to Raster

Topo to Raster by File

Trend

We will not, in this exercise, concern ourselves too much with the theory behind each of these methods.
You should however be aware that there is a lot of statistical theory on the subject of interpolation, which
is an active area of research. This theory should be considered before practical use of these methods.

In preparing this exercise we experimented with Empirical Bayesian Kriging which is reported to be one of
the most advanced of these. We found that it took a very long time to complete, however you are welcome
to try it with the following inputs. Use the input points from "PrecipStn" and Z value field as
"AnnPrecip_in". Set the output cell size to 100 m to improve the spatial resolution.
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Geoprocessing X

L. ; . -
@ Empirical Bayesian Kriging —
Parameters | Ervironments @
Input features
| Precip5tn "|
Z value field
| AnnPrecip_in *|

Output geostatistical layer

Output raster

| emp_bk | ™
Qutput cell size

100 |
Data transformation type

| Meone T|

Sermivariogram model type

Power v|

+ Additional Model Parameters
* Search Neighborhood Parameters
* Qutput Parameters

Following is the result from Empirical Bayesian Kriging
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The irregularity of the surface is displeasing.

Following are inputs for tension Spline interpolation (Spatial Analyst tools). Use the input points from
PrecipStn and Z value field as AnnPrecip_in, and set the spline type as Tension with parameters as
follows. | reduced the output cell size to 100 m to improve the spatial resolution. The result follows:

Geoprocessing > 2 x
] =3
@ Spline =
Parameters | Environments @
Input point features
| PrecipStn *| ™
£ value field
|AnnPrecip_in *|
Output raster
| spline | ™
Output cell size
100 |
Spline type
Tension -]
Weight | 0.1]
Mumber of points | '|E|

This runs a lot faster.
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Now, let’s use Zonal Statistics to compute the average value of the spline precipitation map over each
subwatershed. Select Spatial Analyst Tools = Zonal - Zonal Statistics as Table. Set the inputs as
follows:

— >

Leoprocessing - I %
€ Jonal Statistics as TabDle =
Parameters | Ervironments

Input raster or feature zone data

Subwatershed -| &

Zone field

HydrolD -

Input value raster

spline -

Output table

+

zonespline
Ignore NoData in calculations
Statistics type

All -

Click Run. A table with zonal statistics is created. This contains statistics of the value raster, in this case
mean annual precipitation from Spline over the zones defined by the polygon feature class Subwatershed.

i zonespline X

Field: E Mew @ Delete E Calculate | Selection: QF'} Switch

4 OBIECTID | HydrolD COUMNT = AREA MIM MAK RAMGE MEAM STD SUM
I i 330 29077 200770000 35.006046 38.183269 3.002323 36217122 0.733394 1053085.251297
2 331 92116 921160000 35204449 42596184 7.391735 37.891757 1.616637 3490437.066021
3 332 14916 149160000 38.07918% 40.546021 2466831 39.785346 0631220  593438.21413
4 333 12666 126660000 32473592 40.502689 2.029091 39.656497 0.544171 502289.195576

The HydrolD in this table may be used to join it to the attribute table for the Subwatershed feature class.
As for the elevations above this joined statistics table can be exported to Excel for formatting to prepare
your turn in results.

To turn in: A table giving the HydrolD, Name, and mean precipitation by the Tension Spline method for

each subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest
mean precipitation using a Tension Spline interpolation?

Summary of Items to turn in:
1. Hand calculations of slope at point A using each of the three methods and comments on the differences.

2. Table giving slope, aspect, hydrologic slope and flow direction at grid cells A and B. For hydrologic
slope report results from both D8 and DINF methods. Include in your solution diagrams or sketches that
define or indicate what each of these numbers means for the specific values obtained for cells A and B.

3. A screen capture of your final model builder model.
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4. A table giving the minimum and maximum values of each of the six outputs Slope, Aspect, Flow
Direction and Hydrologic Slope (Percentage drop) by D8 and Flow Direction and Hydrologic Slope
(Percentage drop) by DINF for the digital elevation model in demo.asc. Also turn in a screen shot of the
FlowDirDinf raster calculated using this model

5. The number of columns and rows in the projected DEM. The cell size of the projected DEM. The
minimum and maximum elevations in the projected DEM.

6. A screen shot showing the location of the highest elevation value in the San Marcos DEM.

7. A layout with a depiction of topography either with elevation, contour or hillshade in nice colors.
Include the streams from NHDPIus and Basin and sub-watersheds from the SanMarcos.gdb Basemap
feature dataset.

8. Atable giving the HydrolD, Name, mean elevation, and elevation range for each subwatershed in the
SanMarcos Subwatershed feature class. Which subwatershed has the highest mean elevation? Which
subwatershed has the largest elevation range?

9. Atable giving the HydrolD, Name, and mean precipitation by the Thiessen method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation?

10. A table giving the HydrolD, Name, and mean precipitation by the Tension Spline method for each

subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation using a Tension Spline interpolation?
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